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This supplementary material provides further details about the development and implementation of
the ‘Physics Research in School Environments’ (PRiSE) framework. It is aimed at practitioners interested
in adopting the practices at their own institutions.

S1 Aims
There is no “magic bullet” to increasing physics (or more broadly STEM) uptake and diversity at higher
education — multiple different approaches are needed with each addressing different stages of young
people’s educational journey as well as their key influencers and wider learning ecology in relevant ways
(e.g. Davenport et al., 2020). Furthermore, research has shown that young people’s aspirations are
incredibly difficult to influence (L. Archer et al., 2013, 2014) with standard one-off interventions, or even
short-series, showing no real changes, highlighting the need for more extended and in-depth programmes
for significant lasting impact (see the review of M. O. Archer et al., 2021, and references therein).

Given this complexity, we contructed the aims of the PRiSE programme through a theory of change
(TOC; Sullivan and Stewart, 2006). This approach is recommended by several organisations and has
been applied to other STEM outreach/engagement programmes (e.g. Davenport et al., 2020). A TOC
is designed to rationalise the intended outcomes and impacts of an initiative by outlining causal links.
The process of creating a TOC works backwards, starting at the intended ultimate impact and mapping
the intermediate outcomes (both short-, medium-, and long-term) that are thought to be required to
enable that goal. The resulting outcomes pathway (which may require iterating several times) should be
accompanied by the rationale for why specific connections exist between different outcomes in the theory
narrative along with any underlying assumptions and potential barriers. We note that by no means
are all the causal links presented in a TOC guaranteed to occur, however, by considering them during
development programmes are more likely to realise them. Figure S1 displays the TOC for PRiSE, which
covers participating students (blue) as well as their parents/carers (yellow) and their teachers and school
environment (both red).

The intended impact of PRiSE is to contribute towards the increased uptake and diversity of physics at
higher education. By serving students near the end of their school-based educational journey, somewhat
necessitated by the content and style of open-ended ‘research in schools’ projects, the programme acts
to support students’ existing identity with science in general and enhance, or at least maintain, physics
aspirations to help transform these into degree subject destinations — a known issue at this stage.
Therefore, an assumption feeding into this TOC is that PRiSE students will have an existing positive
association with science beforehand and we make no claim that the PRiSE approach would be effective
for students who are generally uninterested or unengaged with STEM from the outset. Students’ interest
or enjoyment in the subject as well as its perceived usefulness in a career are key factors affecting
degree choices (DeWitt et al., 2019), with students (particularly girls) often thinking physics is less useful
or relevant (Murphy and Whitelegg, 2006). Additionally, the stereotypes and school-based practices
associated with physics make many, even highly-able and interested students, at this age conclude it is
‘not for me’ (L. Archer et al., 2020a). PRiSE attempts to be a factor in addressing all of these factors
in some way. By interacting first-hand with “real physics” through the projects and working with active
researchers, students (especially those from under-represented groups) should feel included and have their
interest in physics enhanced or at least sustained (Thorley, 2020). By experiencing success at ‘being’ a
scientist and meeting similar students from other schools, it is hoped their confidence will be boosted
leading to a feeling that physics is indeed for ‘people like me’ (Davenport et al., 2020). Furthermore,
through working in new ways students should develop numerous transferable skills (Bennett et al., 2018)
which might help them recognise the usefulness of the subject (Soh et al., 2010).

Teachers are much stronger influences on students’ aspirations than university staff/students could
ever be (L. Archer et al., 2013, 2020b). Experience from physics outreach officers (e.g. through discussions
via the South East Physics Network’s Outreach and Public Engagement and Ogden Trust’s Outreach
Officer programmes) has shown that most teachers are more interested in activities for their students
from universities rather than continuing professional development opportunities, which they may seek
elsewhere. Therefore, opportunities for teachers’ development are integrated within the programme
rather than being a separate offering to schools. While the number of students working on PRiSE
may be relatively small, by influencing teachers through our sustained programme, the aim is that the
impacts of PRiSE can be felt much more widely. Indeed, our hope is to affect the environments within
the diverse range of schools we work with on the programme so that they are places that are able to
support and nurture the science capital (L. Archer et al., 2013, 2020b) of all their students, thereby also
contributing to our goal of increased uptake and diversity of physics (Moote et al., 2019, 2020). IOP
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(2014) recommends to help achieve such an environment that schools should raise the overall profile
of science in school, endeavour to build long-term relationships between pupils and role models, and
ensure all teachers are aware of the influence they can have on children’s future careers. We aim to
further all these points by PRiSE providing more collaborative working opportunities between teachers
and students, exciting success stories that teachers and students can share across their schools, and the
gateway to building longer-term relationships between schools and the university. It is likely the teachers
that sign up for such a protracted programme and/or benefit the most from it are relatively engaged
generally. How to enhance the practice of disengaged teachers is a challenge beyond the scope of PRiSE.

Finally, another major influence on young people’s aspirations is family, particularly parents or carers
(e.g. Clemence et al., 2013). Parental engagement is notoriously difficult within school-based programmes
in general (see the review of M. O. Archer et al., 2021), so we simply aim to include parents/carers to
celebrate in students’ project work at the end of the programme. These parents/carers are likely interested
in their children’s education. It is hoped that by witnessing their child’s successes and development
through physics, they will be more positive, and thus supportive, towards physics aspirations going
forward, reinforcing the impacts of the programme.

This TOC for PRiSE was used in motivating the provision within the framework. Evaluating the im-
pact of PRiSE is beyond the scope of this paper / supplementary material and is explored in a companion
paper (M. O. Archer and DeWitt, 2020). We stress that this TOC for PRiSE does not exist in isolation
and other TOCs which focus on different stages of and aspects to a young person’s learning ecology are
required to improve the overall issue of uptake and diversity in physics. For example, Davenport et al.
(2020) present a potential STEM outreach TOC designed towards primary and lower secondary school
students, with outcomes focused more on STEM careers.

S2 Current projects
Queen Mary University of London’s (QMUL) physics research areas concern astronomy (space science,
planetary physics, and cosmology), particle physics (the Standard Model and beyond via particle colliders
and neutrino observatories), condensed matter physics (e.g. material structure, organic semiconductors,
and applications thereof), and theoretical physics (e.g. string theory, and scattering amplitudes). Of
these, it was decided to initially base PRiSE around the space and planetary sciences as well as particle
physics. These exciting topics are thought to inspire awe in the public due to the “big” questions they
address and the senses of scale and wonder beyond our everyday experience (cf. Madsen and West, 2003;
IPPOG, 2020). However, exactly how this science is conducted is not often well understood outside of
academia, particularly at school-level due to the lack of research methods within current science teaching
(e.g. Hodson, 1998; Braund and Reiss, 2006; Yeoman et al., 2017). Currently four projects have been
developed for the PRiSE programme at QMUL, which we briefly summarise here indicating key project
personnel referring to the roles mentioned in the main article (note the outreach officer role for the entire
programme was performed by the first author).

• Scintillator Cosmic Ray Experiments into Atmospheric Muons (SCREAM, 2014–2020)
was adapted by the outreach officer from a dissertation project designed for undergraduates using
a scintillator – photomultiplier tube muon detector (Coan and Ye, 2016; TeachSpin, 2016) fun-
damentally similar to those found in current neutrino experiments such as SNO+, where cosmic
ray muons serve as an important background source that can be used for calibration (Alves et al.,
2015). Students calibrate their borrowed detectors and collect counts of comic ray muons and muon
decays. Initially they use this data to perform a measurement of muons’ mean lifetime (using both
software that comes with the detector and programmes we have created especially) before progress-
ing to a wide variety of potential topics on these cosmic rays such as their angular distributions or
dependence on atmospheric/solar conditions. Since detector usage and particle physics are part of
most A-Level physics syllabuses, it complements their studies. At present QMUL only has four of
these detectors as they are expensive (around £5,000), which limits the number of schools we can
work with each year. As this project has been especially popular with teachers when signing up,
we have made it open only to schools that have successfully undertaken a different project with us
previously, also limiting how long they can borrow a detector to a maximum of 4 years.
Key personnel: Dr Jeanne Wilson (project lead, 2014–2019), Prof Peter Hobson (project lead,
2019–2020), Dr Martin Archer (researcher, 2015–2020)

• Magnetospheric Undulations Sonified Incorporating Citizen Scientists (MUSICS, 2015–
2020) was created especially for PRiSE by the project lead. Geostationary satellite data of
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the “sounds of space”, ultra-low frequency fluid plasma waves in Earth’s magnetosphere, have
been made audible. Students are given this data on preloaded USB flash drives and explore it
through the act of listening (we also provide them with earphones). Audacity audio software
(https://www.audacityteam.org/) is used to analyse any events identified, which can then be
logged in a specially created spreadsheet which performs some routine calculations. We stress that
students do not have to focus on the space plasma physics aspects, which will largely be completely
unfamiliar, but rather just the waves topics that they cover in class both at GCSE and A-Level.
While students are given guidance on how to listen to and analyse the waves, we do not prescribe
to them exactly what to listen out for as we are instead interested in what they pick out them-
selves. This approach has already led to novel and unexpected scientific results on the resonances
present in Earth’s magnetosphere during the recovery phase of geomagnetic storms (M. O. Archer
et al., 2018). Based on these results, an optional ‘solar storms campaign’ was created for 2019/20,
providing more concrete prescribed instructions to build up a dataset of similar events followed by
suggestions of unanswered questions about these resonances that students could investigate. While
a few schools followed this route initially, they all eventually decided to go their own way with it.
Key personnel: Dr Martin Archer (project lead and researcher, 2015–2020)

• Planet Hunting with Python (PHwP, 2016–2020) was initially developed by a post-viva PhD
student, Dr Gavin Coleman, through a one-day-per-week buyout over three months (funded by a
grant obtained by the outreach officer) and has subsequently been modified by the project lead each
year. The project aims to address the UK coding agenda (the UK government’s desire for more
young people to develop computer programming skills, e.g. Department for Education and Gibb,
2018) by applying Python computer programming to data from NASA’s Kepler (Jenkins et al.,
2010) and later TESS (Ricker et al., 2015) missions, whereby students write programmes to detect
exoplanet transits. Transit photometry, where an exoplanet blocks some of the star’s light, can be
fairly easily understood by school students in terms of geometry and the equations from A-Level
physics. The students try to independently implement each step laid out in their guide (period
detection, phase folding, model fitting, and parameter estimation) applied to specially selected star
systems chosen for their relative simplicity. Example code is given to teachers. While extension
activities are suggested, so far very few students have progressed beyond the prescribed activities
within a single year, though some students have returned for a second year making further progress.
Key personnel: Prof Richard Nelson (project lead, 2016–2020, and researcher, 2017–2020), Dr Gavin
Coleman (researcher, 2016–2017), Dr Martin Archer (researcher, 2016–2017), Francesco Lovascio
(researcher, 2020)

• ATLAS Open Data (2017–2020) was adapted by the outreach officer for PRiSE from a public
resource produced by CERN aimed at undergraduates (ATLAS Experiment, 2017). An undergrad-
uate summer student, under the instruction of the outreach officer, produced a guide so that school
students could build up to the documentation provided online by CERN. At kick-off workshops
students play a loaded dice game, developed by the outreach officer and freely-available online as a
resource (PRiSE, 2020), which serves as an analogy for why particle physicists need to use statistical
methods and big data in discovering new particles such as the Higgs boson (ATLAS Collaboration,
2012). This leads into the main activity, using CERN’s interactive histograms to see how performing
cuts on the data increase/decrease the significance of the desired signal, i.e. the Higgs, compared
to the backgrounds. While the CERN guides provide extensions by using their statistical software
(ROOT) for more detailed analysis, this has been beyond almost all PRiSE students thus far, with
most groups simply investigating the underlying physics behind their chosen cuts to justify them.
Key personnel: Dr Eram Rizvi (project lead, 2017–2019), Dr Seth Zenz (project lead, 2019–2020,
and researcher, 2018–2020), Joe Davies (researcher, 2019–2020)

Of the current projects at QMUL, only MUSICS at present has the scope to lead to novel publishable
scientific research, which it already has done. The Kepler dataset has largely been mined of the clearest
exoplanets, often now requiring advanced machine learning techniques for new discoveries (e.g. Shallue
and Vanderburg, 2018) which are currently also being implemented on TESS. The other two projects
have limitations based on the equipment (Coan and Ye, 2016; TeachSpin, 2016) and amount of data used
(ATLAS Open Data’s first release contained only a fifth of the data used in the Higgs boson’s discovery,
ATLAS Collaboration, 2012, however, more data was released in 2020). While this is not perhaps ideal,
it is due to the realities of pressures on academic staff time limiting their ability to develop outreach
projects from scratch (e.g. Thorley, 2016). M. O. Archer (2017) recommended that the development and
delivery of ‘research in schools’ projects should be distributed within each research group sharing the

4

https://www.audacityteam.org


load out amongst academics, post-docs, and PhD students. This would allow more schools to participate
without overburdening individual researchers. However, this research group buy-in has proven difficult to
achieve at Queen Mary due to an overall poor culture towards public engagement and outreach in their
physics department, a fairly common barrier to public engagement in general (Burchell et al., 2017).
Responsibilities have thus largely been falling to only a few people per PRiSE project which has limited
the number of schools which could be involved each year. Nonetheless, there have been some positive
steps in the last year with project leads, along with the outreach officer, being able to convince a few
early career researchers to help with delivery, which may indicate the department slowly moving towards
a more embedded approach. Institutions with a more positive culture of public engagement and outreach
likely could support even more schools with research projects than has been possible at QMUL.

S3 Implementation practicalities
This section is designed to provide sufficient additional detail to enable practitioners to fully understand
how the PRiSE framework has been implemented, with the aim of informing their schools engagement
practice.

S3.1 Activity stages
• Prescribed work: This stage involves following a set of instructions to undertake an experi-

ment/activity designed to cover most aspects of an investigation and to build their confidence in
the project topic. Students are still required to problem solve throughout these stages and we
purposely do not provide them with all the answers to prompt this, though teachers are given
guidance in their resources to support student efforts. The stage is designed to enable students and
teachers to initially be able to access and interact with the research, enhance teachers’ knowledge,
and hopefully make underrepresented groups feel included in physics (cf. Figure S1).

• Independent project: This continues in a similar way to the prescribed work except now inde-
pendently motivated. In visits and webinars the question has been raised by students whether there
is a risk that they investigate the same thing as another group at a different school, though given
the broad scope of most of the PRiSE projects so far this has rarely occurred. Potential research
questions are suggested in the guides provided, with further advice for teachers on these being
given in their versions, and students’ ideas are discussed during visits and/or webinars. During
this stage we aim that students’ interest in physics is increased or sustained through pursuing their
own research questions and that they develop physics-related transferable skills (cf. Figure S1). We
encourage teachers to work with their students throughout this stage, e.g. holding regular meetings,
which may help enhance their perceptions of students’ ability (cf. Figure S1).

• Writing up: Near the end of the project students produce either a scientific poster or talk to be
presented at our annual conference. Guidance on how to approach these is provided online as well
as during visits and webinars. We have found that with the researcher support provided that all
student groups that persist with project work to this stage are able to produce a poster or talk,
thereby experiencing success at ‘being’ a scientist (cf. Figure S1).

S3.2 Interventions
• Assignment: Using existing teacher networks, such as the Institute of Physics’ Stimulating Physics

Network (Hartley, 2011) and the Ogden Trust School Partnerships (Ogden Trust, 2020) in the UK,
not only allows us access to schools from lower socio-economic areas given the networks’ focus
but also act somewhat like a word-of-mouth recommendation. We have found these networks to be
more successful at attracting new schools to the programme than our existing schools events mailing
lists. Teachers fill out an online form providing school and contact details, project preferences, and
the estimated number of students who will be involved. Previously participating schools have to
reapply each year. Once applications are in we assess the capacity of the programme (taking into
account data about the schools) and inform teachers before the summer break whether their school
has been allocated a project or not. Most schools are assigned only one project, which both helps
with logistics and makes it easier for teachers to manage, and where possible we take into account
their stated preferences though this is not always possible given the researchers’ workloads.

5



• Kick-off: Due to constraints on time for academic members of staff leading projects, the kick-
offs are typically an evening event on (university) campus. In some cases where schools could not
attend the event we have repeated it at their school. Projects led by non-academic staff are usually
hosted in-school, sometimes within a normal lesson or at lunchtime/after-school depending on the
teacher. The events start with a 20–30 minute introductory talk by the project lead concerning
the underlying physics and research topic, leading up to an overview of what the project is about,
which is presented to students as an opportunity that they can take advantage of if they wish.
The outreach officer then discusses the differences between learning styles in the research project
compared to their regular classroom experience, how the project will work, the support available,
and how to go about obtaining this. The event ends with a hands-on workshop for at least 20 minutes
usually run by the outreach officer and facilitated by researchers (though not always the project
lead). This workshop, which teachers as well as students are actively encouraged to participate in,
typically forms either the early part of or a lead into the initial stage of the project work. Experts
are on hand to assist with any questions or initial troubles, with the aim of getting the students
and teachers to a place where they can continue this work without too much extra help for the next
month or so. Students and teachers are given all the project’s resources so they can begin/continue
their project work from this point on at their school. The outreach officer will also have an informal
chat with (particularly new) teachers concerning how to go about undertaking and supervising the
project, answering any questions or concerns they may have with either the science, activities, or
project management.

• Visit: These school visits by researchers are often administered through a rolling Doodle (http:
//www.doodle.com) poll where teachers can sign up to a session given the researcher’s availability.
Schools taking advantage of this stage typically receive only one visit, though if further demand
is communicated we try to accommodate one (or occasionally two) additional visits. The visits
typically last around an hour and occur around the stage where groups have finished the prescribed
activities and are thinking about or are in the early stages of undertaking their independent research.
They are very much student-driven meetings, where the researcher asks the groups of students to
show what they have done, probes their understanding of this, puts their work into the context of
current research, provides answers to any questions the students have, and gives advice on what the
direction and next steps with their specific project ideas might entail while bearing in mind what
methods/results may be achievable within the timeframe of the project. Only active researchers
have the necessary expertise to draw upon in offering such bespoke, tailored guidance to students
and teachers working on projects in their research area. With one project (ATLAS) and for a few
schools on other projects it has not been possible to have in-person visits for logistical reasons,
however, similar interactions were done via specifically arranged Skype calls to the schools in these
cases. Teachers are encouraged to participate in these meetings and additionally further informal
chats (similar to those taking place during the kick-off) between the researcher and teacher occur
to help with their project supervision and continuing professional development. These researcher
interactions with students and teachers are aimed at not only supporting project work within the
schools, but further enhancing teachers’ knowledge and students’ sense of inclusion in physics (cf.
Figure S1).

• Webinars: One project (MUSICS) has experimented with additional support to schools through
monthly drop-in webinars between November–February, providing further opportunities for students
and teachers to ask questions of the researcher and get advice on how to progress with their project
work in a similar manner to the visits. This was first trialled in 2018/19 through a Google Hangout
simultaneously streamed on YouTube, however, this option was later discontinued so a solution using
a Skype group call also broadcast to YouTube (via the NDI® feature and using Open Broadcast
Software, https://obsproject.com/) was implemented in 2019/20. The YouTube streams are
unlisted so that only project students with a link can access them, making the webinars a safe
space for them to discuss the project. While almost all students and teachers preferred to simply
join the YouTube stream and contribute via its live chat facility, the rationale behind incorporating
the Hangout/Skype option was so that participants could directly talk to the researcher and/or
show their work. In 2018/19 the webinars were organised in a somewhat ad hoc manner and due to
technical limitations the only way of communicating the links to join was via an email immediately
before the webinar. With the move to Skype we were able to create a stable hyperlink to join
the group as well as being able to embed the YouTube events in advance on a password-protected
webpage, both of which allow for easier access to the webinars. In terms of organisation, at the
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beginning of the 2019/20 academic year we sent out an online form asking teachers to identify when
might be the best times for webinars. While the response rate for this was low (only four), we
used this to set a regular monthly schedule (in this case the first Monday of each month at 4–5pm)
which was communicated to teachers far in advance. All these changes considerably increased the
uptake of webinars: 10 out of 14 schools participated in at least one webinar in 2019/20 compared
to only 2 out of 14 the previous year. The rationale behind webinars is that they further support
the projects and their aims in a way that makes efficient use of researchers’ time.

• Ad hoc: We explain at the kick-off meetings that when students get stuck at any point (which
they invariably will do due to the nature of research) they should try to first tackle this themself,
before discussing in their groups, and then raising with their teacher. In general, teachers act as the
primary contact to students offering encouragement and any support or advice they can. If students’
questions go beyond what their teacher can answer and is not covered by the teacher guides we
provide, the teachers should get in touch through the outreach officer. This is done not only for
logistical and safeguarding reasons, but also provides further opportunities for university–teacher
dialogues that can contribute to their professional development. Some teachers, however, instruct
their students to email directly. Not all schools require this option of further support and we have
not yet been overloaded with additional questions. Only in a few cases has the outreach officer
not been able to directly answer the question, subsequently passing it on to a relevant researcher
to answer, though in general this would depend on the background and experience of the outreach
officer.

• Comments: These are currently given by the outreach officer, though in general this would de-
pend on their background/experience and could instead be done by the relevant researcher role(s).
Teachers (or students directly) email their work to the outreach officer and receive annotated ver-
sions back the week before the final deadline, allowing the students at least a few days to implement
any changes.

• Conference: The evening is primarily based around oral and poster presentations by the students.
Food and drink are provided during the poster session and we also put on various physics demon-
strations. At the end of the evening all student groups are congratulated and given a thank you
letter, with a select number of groups highlighted by researcher judges also receiving prizes in the
form of various science gadgets (some prize winners have also had the opportunity to present their
research at a national student conference hosted by the Royal Society). As of 2019 we limited the
number of talk slots available to four in total, both for time and so each topic can be covered.
Schools are only able to solicit one talk (where desired) by providing a title and abstract in advance
(early March), with the decisions of who will present being made that same week. There are cur-
rently no limits on the number of posters a school can enter into the conference. The event further
enables students to experience success at ‘being’ a scientist as well as getting to know other people,
outside of their school from a variety of backgrounds, with interests in physics. It is hoped that
this might lead to increased confidence, seeing themselves as equals in physics, and ultimately that
physics is something for ‘people like me’ (cf. Figure S1). The conference provides parents/carers
in attendance the opportunity to have a positive experience with physics and witness their child’s
interest and ability in the subject, which could in the long-term result in their supporting and
encouraging their child’s physics aspirations (cf. Figure S1). Finally, from teachers’ perspectives
the conference lends an avenue for them to support and encourage their students as well as share
successes across their school (cf. Figure S1).

The outreach officer typically sends updates and reminders about these possible interventions to all
teachers involved fortnightly throughout the programme. This frequency attempts to tackle teachers’
generally low levels of response to a single email (Sousa-Silva et al., 2018, also reported teachers’ gen-
erally poor communication through ORBYTS). In addition to email communications, we also set up a
password-protected teacher area on our website in 2019 which always contains the latest information on
the programme. It appears from website analytics that teachers have used this to some extent (there
were 76 unique page views amongst the 38 teachers involved that year), though we are unsure which
teachers these were and how often they visited the page throughout the programme. For any on cam-
pus events, schools travel to Queen Mary using London’s extensive public transport network and we are
unable to offer schools compensation for travel expenses due to limited funding. Outside of London or
other well-connected cities this travel may be a greater barrier to participation than in our case so may
need further consideration.
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S3.3 Resources
• Project poster/flyer: At the start of the academic year we send posters/flyers to teachers to help

attract attention to the project within their school. Some teachers had been making their own such
adverts previously, which motivated us to create these.

• Project guide: Our guides are presented in the style of an academic paper. Printed copies of
these are given out at the kick-off event and electronic version can also be found on the project’s
page on our website. These serve as an introduction, providing enough information for students
to start working on their project and be something they can refer back to throughout. However,
the guide is not intended to be exhaustive (that would be impossible given the open-ended nature
of the projects) and students are made aware that we expect them to read additional materials as
they progress. Throughout the guides there are exercises and discussion questions for students to
consider, designed to help them think more critically about their project work. Teachers’ guides
include answers to the exercises, hints and tips about different methods, common pitfalls that
students make etc. and these are distributed to teachers at the kick-off, via email, and also stored
on the password-protected teacher webpage. These project guides have been updated every single
year based on feedback and professional experience, which is straightforward to do given the chosen
style compared to say a more illustrated glossy guide that would require a professional designer
each time.

• Project webpage: Including previous work on these had been suggested by students and teachers
in feedback for a few years as something that would be helpful. Some projects have also produced
videos which provide further information on the science / research area or demonstrate how to use
tools provided for the project, which have been included on these pages.

• ‘How to’ guide: These articles have been produced by the outreach officer. The most used of
these are the guides on producing scientific talks and posters that we point students and teachers to
ahead of the conference. While articles in this section designed for teachers have also been planned,
which would highlight elements of good practice that have emerged from other teachers on how to
successfully integrate and nurture project work within their schools outside of the support offered by
researchers, we have not had sufficient time or detailed input from teachers to be able to co-create
these yet.

Examples of all these resources are given in section S4.

S3.4 Funding
The operational costs of PRiSE’s interventions have largely been covered by QMUL’s departmental
physics outreach budget. Running the kick-off events and conferences is comparable in cost (∼£3,000
p.a. at PRiSE’s current scale) to many summer school programmes aimed at high school students which
universities offer and often absorb the cost of. However, as noted in the review of M. O. Archer et al.
(2021), summer schools have severely restricted places (∼10–30 students) and limitations on impacts
upon students. The PRiSE model thus potentially offers much greater value for money.

The programme management falls within the scope of the funded outreach officer post, a role which
many university departments employ (e.g. Ogden Trust, 2020). Whether to pay early career researchers
or assign workload allocations to academics in delivering projects would realistically be down to the
policy/strategy of the department or institution. In the case of Queen Mary, we have opted to only
offer pay to PhD student researchers (sourced from the department’s outreach budget) to try to increase
uptake of engagement. Workload allocation in outreach / public engagement for academics is dedicated
only to roles aimed at embedding engagement throughout the department, e.g. champions in research
groups who help recruit their colleagues to contribute to PRiSE. Delivery of engagement is considered
an expectation of the role of an academic, though significant contributions may be used as criteria for
promotions. Grants have been obtained to assist with project development, as detailed in section S2.

If institutional funds are not available for the delivery of a ‘research in schools’ programme, we would
recommend either costing these into research grants as impact-related costs or employing the ORBYTS
funding model of charging independent schools to allow both them and a few less-resourced schools to
participate (Sousa-Silva et al., 2018).
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S4 Example resources
Finally we give examples of the resources within the PRiSE framework. We display the posters (A3 size)
provided to teachers to advertise projects to their students in Figure S2. Leaflets (A5) size used similar
designs and content. We also show a project webpage (Figure S3) and teacher guide (Figure S4), in both
case for the MUSICS project. Student guides are identical but do not include the red text, which is for
teachers only. Finally, a ‘how to’ style online guide for students is given in Figure S5, specifically the one
on creating research posters.

qmul.ac.uk/spa/researchinschools

The Physics Research 
in School Environments 
programme gives 
students the opportunity 
to experience authentic 

through exciting projects. 

The ‘SCREAM’ project
•   Use particle detectors like 

those in cutting-edge neutrino 
experiments

•  Measure the properties of 
the electron’s unstable 
cousin - the muon

•  Research topics including 
cosmic ray origin and special 
relativity

UNCOVER
the invisible shower

of cosmic rays

qmul.ac.uk/spa/researchinschools

The Physics Research 
in School Environments 
programme gives 
students the opportunity 
to experience authentic 

through exciting projects. 

The ‘MUSICS’ project
•   Access satellite data of Earth’s 

magnetic shield in space – the 
magnetosphere

•  Uncover the impulses, resonances 

everyday lives   

LISTEN
to the sounds

of space

qmul.ac.uk/spa/researchinschools

The Physics Research 
in School Environments 
programme gives 
students the opportunity 
to experience authentic 

through exciting projects. 

The ‘Planet Hunting
with Python’ project

programming to do research

passing in front of distant stars

•  Apply your code to Kepler Space 

yourself

DISCOVER
planets around 

other stars

qmul.ac.uk/spa/researchinschools

The Physics Research 
in School Environments 
programme gives 
students the opportunity 
to experience authentic 

through exciting projects. 

The ‘ATLAS Open Data’ project
•  Learn about the fundamental 

particles and forces of nature
•  Access the actual data produced  

in the experiments at CERN
•  Apply the same statistical techniques 

SEARCH
for particles at the  
Large Hadron Collider

Figure S2: Posters for advertising the four PRiSE projects at QMUL.
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Figure S3: Example PRiSE project webpage.
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U S IC
Magnetospheric Undulations Sonified Incorporating Citizen Scientists

Teacher Guide

Dr Martin Archer
School of Physics and Astronomy, Queen Mary University of London

qmul.ac.uk/spa/musics

Abstract

The magnetosphere is the space environment formed due to the interplay of the solar wind with Earth’s magnetic
field. It is highly dynamic and rife with analogues to sound waves in space, fluid plasma waves which occupy the
ultra-low frequency (ULF) range (< 1 Hz). Many questions concerning ULF waves still remain, such as how often and
at what frequencies do various resonances of the magnetosphere occur. This research project allows you to study these
waves by using perhaps the best pattern recognition system that we know of, the human auditory system. By listening
to satellite data and using audio software you will explore the waves present in near-Earth space and undertake your
own research project in groups, the findings of which could contribute to improving our understanding of our protective
magnetosphere.

1 Introduction

Earth’s magnetosphere is the space environment around the Earth formed by the interaction of the solar wind
(plasma continually streaming away from the Sun at supersonic speeds) with the Earth’s magnetic field. The solar wind
compresses this magnetic field on the dayside, confining it to typically within 10 times the Earth’s radius (RE), whereas
it sweeps back the magnetic field lines on the nightside to some unknown length, possibly up to 1000 RE. In turn the
solar wind is itself slowed and deflected around the magnetic barrier (by a shock wave, the bow shock, since the flow is
supersonic). Figure 1 illustrates some of the basic structure of the magnetosphere.

The magnetosphere is far from static, for example the solar wind pressure and magnetic field continually change causing
the size and shape of the magnetosphere to adjust accordingly. These dynamics of the magnetosphere manifest in
many ways, including a number of different plasma waves. In the ultra-low frequency (ULF) range, defined as
waves/oscillations of frequency <1 Hz, the plasma can be treated as a single fluid in much the same way as air or water.
This means there are two fundamental types plasma waves:

• Magnetosonic waves: the equivalent of sound waves in plasmas, however, unlike a gas in which sound is driven
by thermal pressure only, plasmas also exhibit magnetic pressures too hence the name of these waves. These waves
can have both longitudinal and transverse components and can transport energy across magnetic field lines.

• Alfvén waves: a sister wave not possible in gases but similar to some seismic waves in solids. These are analagous
to waves on a string since magnetic field lines in a plasma exhibit a form of tension. Their wave perturbations are
perpendicular to the background magnetic field i.e. transverse, so they do not increase the magnetic field strength,
and they transport energy along the direction of magnetic field lines.

Inside the magnetosphere both these waves have approximately the same wave speed: the Alfvén speed vA = B/
√
µ0ρ

where B is the magnetic field strength, ρ is the plasma mass density and µ0 = 1.2566 × 10−6 m kg s−2 A−2 is the
permeability of free space/magnetic constant. Therefore the wave speed (and thus the frequency of for example any

Figure S4: Example PRiSE project teacher guide.
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Figure 1: Structure of Earth’s magnetosphere.

resonances) depends on both the magnetic field and the amount of plasma present, both of which change with location
and time throughout the magnetosphere in ways that we still don’t fully understand yet.

Exercise: At geostationary orbit magnetic field strengths of ∼90 nT and proton number densities of
∼10 cm−3 are typical. What is the wave speed under these conditions?

First don’t forget to convert the units into SI i.e. 90 nT = 90 × 10−9 T and 10 cm−3 = 10 × 106 m−3. Also
don’t forget to include the mass of the proton when calculating the mass density

vA = B/
√
µ0ρ

= 90× 10−9/
√

1.2566× 10−6 × 10× 106 × 1.67× 10−27

= 620 km s−1

Note we tend to use km rather than m for distance due to the generally large scales involved.

It is worth mentioning that the majority of the dynamic solar wind – magnetosphere interaction is invisible, bar
phenomena such as the aurora. Therefore much of our understanding of magnetospheric processes come from space-
craft/satellites in orbit around the Earth which can directly measure the particles and fields. There are still many
aspects about these waves we do not know. For example, the variability in the frequency of different types of mag-
netospheric resonances (such as those shown in Figure 2) are not well understood. You will therefore be investigating
various aspects of ULF waves in the magnetosphere through the use of spacecraft observations at geostationary orbit.

Exercise: Field lines near the dayside magnetopause are typically about 16 RE long, where 1 RE = 6378.1 km
is the radius of the Earth. Using your Alfvén speed from earlier and assuming a constant wave speed over
the entire field line, estimate the fundamental frequency of standing Alfvén waves on these field lines (like
standing waves on a stringed instrument) as illustrated in Figure 2.

Fundamental wave will have wavelength

λ = 2× 16× 6378.1

= 20, 410 km

Using the relation between speed, wavelength and frequency we have
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f = vA/λ

= 6200/20410

= 0.0304 Hz

= 30 mHz

The assumption of a constant wave speed is, however, not really valid in the magnetosphere since of course
the magnetic field strength gets much larger at the poles meaning much larger wave speeds. A way around
this is to use the time-of-flight technique whereby the frequency of the wave is found by integrating the
amount of time it takes a wave to travel infinitesimally small segments of the field-line i.e. the period of the
standing wave is

τ = 2

∫
ds

vA

This is beyond the scope of the students’ projects though. Note that the variability in these fundamental
frequencies of field-line resonances are thought to be some 40–80%, hence the still active research in this
area.

Exercise: Standing magnetosonic waves can also form, as shown in green in Figure 2. Assuming a typical
distance between boundaries of 6 RE and that the outer boundary is open (an anti-node like in some wind
instruments) whereas the inner boundary is fixed (a node), estimate the fundamental frequency of these
waves again assuming constant speed.

Fundamental wave will have wavelength

λ = 4× 6× 6378.1

= 153000 km

Using the relation between speed, wavelength and frequency again

f = vA/λ

= 620/153000

= 0.0041 Hz

= 4.1 mHz

Variability in frequency of these resonances are thought to be around 28–72% but is not clear how often they
occur.

2 Data

The Geostationary Operational Environmental Satellites (GOES) are a series of spacecraft in geostationary orbit above
North America. They are equipped with Space Environment Monitoring Subsystems (SEMS), which include a mag-
netometer for measuring changes to the magnetospheric magnetic field, useful for both research purposes and in
monitoring/forecasting space weather - which concerns how phenomena from space can affect our everyday lives, such
as disrupting our technology.

An example of the GOES spacecraft which were available in 2008 is given in Table 1, listing their location in longitude as
well as how to calculate their local time (LT). Local time essentially measures position relative to the Sun (think about
why we have time zones for instance). Therefore, a local time of 12h/noon means the spacecraft is directly between the
Sun and the Earth; whereas a local time of 00h/midnight means the spacecraft is behind the Earth compared to the
Sun. See Figure 3 for an illustration. In geostationary orbit this is a very easy quantity to calculate as the spacecraft
orbit at the same rate as the Earth’s rotation, so there is a direct link between Universal Time (the standard time used
in science, a modern continuation of Greenwich Mean Time) and the spacecraft’s Local Time.
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Figure 2: Illustration of just some of the ULF wave modes supported by Earth’s magnetosphere, highlighting the variety
present and hence why it remains an active area of research.

Spacecraft G10 G11 G12

Geographic Longitude 60° W 135° W 75° W
LT [h] = UT [h] + -4 -9 -5

Table 1: Summary of the three GOES spacecraft which were available during 2008. The full spacecraft locations with
year are contained within the provided spreadsheet.

GOES magnetometer data can be used to research ULF waves in Earth’s magnetosphere since the magnetic field moves
with the plasma. In this project you will be undertaking such a study using the novel approach of actually listening to
these waves. This is because, unlike many automated computer algorithms, the human auditory system is perhaps the
best pattern recognition system that we know. In order to make the freal =0.5–244 mHz waves audible to human ears
though, the data has had to be rescaled in time

taudio = treal/(Fs ×∆treal) (1)

and thus also frequency
faudio = freal × Fs ×∆treal (2)

where Fs = 44, 100 Hz is the sampling frequency of the audio file and ∆treal = 2.048 s is the time resolution of the
magnetometer data used. This rescaling converts an entire year of magnetic field measurements into an audio file less
than 6 min long.

Exercise: Calculate how long an entire day in is in the audio files.

taudio = treal/(Fs× dt)
= (24× 60× 60) / (44100× 2.048)

= 0.9566 s

Exercise: If the time in the audio are quoted in seconds to either one, two or three decimal places, what
level of accuracy does this correspond to in real time?
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treal = taudio × Fs× dt

=





0.1× 44100× 2.048 One decimal place

0.01× 44100× 2.048 Two decimal places

0.001× 44100× 2.048 Three decimal places

=





9032 s or 2.5h One decimal place

903 s or 15min Two decimal places

90 s or 1.5min Three decimal places

i.e. students should quote times as accurately as possible here. Clearly one decimal place is not nearly
enough, though two may be sufficient depending on the circumstances e.g. long-lived waves.

Exercise: Calculate the date and local time of G11 in 2008 at 3m24.054 s into the audio.

First calculate the real time from the beginning of the year

treal = taudio × Fs× dt
= (3× 60 + 24.054)× 44100× 2.048

= 18429504 s

= 213 days 7h 18min

Note we only quote the time to the nearest minute because, as shown earlier, the accuracy of our times
from the audio are only good to a couple of minutes in real time. Using a day of year calendar e.g.
http://disc.gsfc.nasa.gov/julian calendar.shtml the date is 1 Aug 2008 (remember that 2008 is a leap year
and the day of year starts at 1 and not 0). We now calculate the local time at GOES 11:

LT = UT − 9h

= 7h 18min− 9h

= 7.3− 9

= −1.7h

= 22h 18min

Note we must keep the local time within the range 0–24 h, just like with hours during the day. Since Local
Time is a measure of spatial position relative to the Sun though, we don’t have to worry about altering
the date as one would when working out the date and time for a given time zone, compared to GMT (or
equivalently UT).

You can use the provided spreadsheet to automatically do these conversions from now on. The filename of your audio
files are in the format:

g10 2008 Ball 10nT diff.ogg

• g10: which spacecraft the data is from

• 2008: the year the data is from

• B : magnetic field data in the following co-ordinates

– pol = poloidal component which points radially outwards from Earth

– tor = toroidal component which points eastwards

– com = compressional which points along the magnetic field

– all = a combination of all three with pol in the left channel, tor in the right and com shared between both.
This is good for initially listening to the data.

• 10nT: the data has been divided by this amplitude factor to give dimensionaless waveform units between -1 and 1

• diff: if present the data has been differenced in time to make spectograms clearer
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Figure 3: Diagram looking down on Earth’s North Pole, demonstrating local time (LT) as a measure of position relative
to the Sun.

Figure 4: View in Audacity with the original waveforms shown in the top panels and the log(f) spectroview of the
differenced waves in the bottom panels.

3 Method

You will be using an audio editing package, Audacity, to listen to and analyse the magnetic field data provided. If this
software is not installed on your computer, you can download a portable version at http://portableapps.com/apps/music video/audacity portable.

Audacity allows you to look at audio either as a waveform or as a spectrogram (a visual representation of the spectrum of
frequencies in the audio as they vary with time). For the latter, you should (at least initially) use the log(f) spectrogram
view since this is closer to how we interpret sounds ourselves and also allows you to clearly see the full range of frequencies
from low to high. You may need to change some of the Preferences (in the Edit menu of Audacity) to show the ULF
waves more clearly e.g. Window Size=1024, Maximum Frequency=20000 Hz, Gain=0 dB, Range=60 dB.

Note that the differenced waves (i.e. those with “diff” in the filename) will show the clearest spectrograms, whereas the
original ones (i.e. without “diff”) will show the clearest waveforms. It may therefore be beneficial in your analysis to
import both of these tracks into Audacity and mute one of them, as displayed in Figure 4.

In your analysis you may wish to use a number of Audacity’s tools and effects, for example:

• Analyze > Contrast: This can be used to measure the root mean squared (RMS) of the selected audio, a measure
of the overall volume/amplitude.
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• Analyze > Plot spectrum: Quantifies the amount of signal at each frequency for the selected audio, which can
be used to find any clear peaks at specific frequencies.

• Effects > Spectral edit multitool: By making a selection in frequency and time in spectrogram view, you
can filter out unwanted signals. This may be useful if multiple signals at different frequency ranges are present. If
this isn’t available, you can do the same using low and high pass filters.

• Effects > Noise Reduction: By providing a sample of noise or unwanted signals, these are reduced thereby
making other signals more prominant.

You should watch the ’How To’ guides online and read the Audacity Manual (see section 5) for more details on all these
tools/effects and others. Be careful not to overwrite your audio file with any changes you may make to it in the analysis
process.

You may wish to add labels/markers for any events/sounds you find. This can be done by pressing Ctrl+M to add one
at the playback position, i.e. when you’re listening to the audio, or Ctrl+B to add a marker to the selected audio. Note
that you can add text to your markers as a description.

4 Research

You will be conducting independent research into magnetospheric ULF waves and oscillations.

4.1 Initial Activities

As a first step you should simply listen to some of the sonified magnetic field data to get accustomed to what it sounds
like and how to use Audacity. So pick a year and spacecraft and listen to one of the files to start with. Any sound
event you pick out to investigate should be relatively short, no more than a few seconds in the audio. Below are some
suggested things to try, you should initially attempt at least two of the following:

• Pick a distinct sound and characterise it.

– How would you describe the sound? This is subjective, but it may help distinguish between the different
types of waves that are present.

– How loud is it? What is its RMS amplitude as measured by the Analyze > Contrast tool? Can you convert
this from dB back into the physical units of magnetic field in nT? Amplitudes should be estimated using the
non-diff files. They can either try and read off the amplitude of the waveform or measure the RMS within the
Contrast Analysis tool. Students may need to convert from decibels to the (dimensionless) waveform units:

A[dB] = 20 log10A

A = 10A[dB]/20

Note the factor is 20 and not 10 because we are not converting to power, which is A2, here. The peak
amplitude of a perfect sine wave is related to the RMS by a factor of

√
2. Don’t forget also to multiply the

dimensionless waveform units into physical units using the 10nT factor at the very end. This conversion is
implemented in the spreadsheet too.

– Look at the spectrogram or plot a spectrum (Analyze > Plot Spectrum) using the diff file. Does it have
a clear peak at a single frequency or set of frequencies/harmonics? Or does the sound show enhancements
over a wide range of frequencies? Remember that spectra or spectrograms should be done with the diff files.
The reason for this is that, like many other physical systems, the background noise profiles approximately
follows a 1/f spectrum meaning that there is more power at low frequencies than at high. Spectrograms with
the normal files will therefore be red near the bottom and blue near the top irrespective of what sounds are
present as shown in the top panels of the figure below. The diff file essentially flattens out this background by
taking the time difference (or derivative in time) so features on top of the 1/f noise are more distinguishable,
therefore serving itself better for spectra and spectrograms as demonstrated in the bottom panels below.
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If a number of well defined frequencies are present, it is likely a standing wave of some sort within the
magnetosphere and you can attempt to estimate the fundamental frequency. Often the fundamental frequency
itself will not be excited/detected though by calculating the spacing between the detected harmonics or
matching the ratios of these frequencies you can usually get an idea as to which harmonics they are.

– Does the frequency or amplitude change as part of the sound? Is there a recurring pattern to this? The
spectrogram is key to this first part. The frequency can change because of the changes to the wave speed
(magnetic field strength and/or density) or the field-line length. These two factors can change either because
the spacecraft is sampling a different region of the magnetosphere or that these quantities have actually
changed e.g. in response to a change in the solar wind.
Similarly with the amplitude, this may be due to the wave amplitude actually increasing/decreasing due to
driving/damping or because the spacecraft has moved into/out of the region where these waves are occurring.

– Is the wave predominantly poloidal, toroidal or compressional? This can inform what type of plasma wave
it actually is. If it is solely poloidal or toroidal this points to Alfvén waves as these are the transverse
components of the magnetic field. A compressional wave must be magnetosonic in nature.

• Try to identify at least three different types of wave events / sounds that are present?

– How would you describe the sounds?

– Look at the spectrogram or plot a spectrum. Can you relate how the waves sound to the different types of
spectra? Broadband waves (waves with enhanced power across a wide continuous range of frequencies) should
have more noisy or thud like sounds compared to waves of distinct frequencies which should have sounds a
bit more like musical instruments.

– Where do these waves occur in local time? e.g. are they around for example dawn (06:00), noon (12:00),
dusk (18:00) or midnight (00:00)? This only really applies to sounds less than a day in duration, otherwise
it’s clear the wave is a global phenomenon and likely of solar wind origin or due to a geomagnetic storm.

– How long until the next similar event occurs? Is this waiting time always the same or does it differ between
different events? You could build up a histogram of waiting times to see whether the events occur regularly
(peaked distribution at a specific waiting time), at random (exponential distribution whereby you could use
a fit to get the characteristic waiting time) or some other distribution.

• Is there an identifiable daily cycle in the ULF activity?

– Where in local time do they occur?

– How variable is this cycle from day to day? The frequencies and amplitudes should vary from day to day, the
variability of these is a key research question at the moment.

Often students find two effects which are not physical. Firstly there are some periods in the audio of complete silence.
This is where data is missing and could be for a variety of reasons. It is therefore not a particularly instructive area to
focus on and students should be careful not to factor in any periods of silence in their analysis. Secondly there are some
signals from the satellite itself present in the data at the high end of the audible frequency range which follows a daily
cycle as shown below. It is clear from the very well defined frequencies and perfect repetition that these waves are not
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physical and are thus not worth investigating futher.

4.2 Independent Research

In your research groups you should now decide what it is you’d like to research in more detail using the sonified magnetic
field data. This can build on some of the sounds you worked on in the initial activities. You should attempt to identify,
analyse and catalogue ULF events which fit within your chosen topic. Here are few ideas or approaches you may wish
to take in your research:

Approaches

• Case studies: You may wish to focus on just one event or a handful of similar ones. These types of studies are
particularly important for rare events. You should then perform thorough analysis on it to fully characterise when
and where it occurred and what the waves’ properties were. Looking for the same event at the different spacecraft
may help get a feel for size. You could also try to find out what geomagnetic or solar wind conditions were present
during the wave. You may not be able to determine with certainty what caused the event, but that is fine - often
even professional researchers don’t have enough information to do so. Students may need additional data to look
into their case study events, please get in touch if you need help finding this.

• Statistical surveys: Ideal for wave events that occur many times within the data, statistical studies can help
us understand how often and where similar events occur and what range of properties they have. You should
decide what aspect(s) of the waves you’d like to investigate in this manner (e.g. frequency, RMS, local time, time
between events) and attempt to build up a comprehensive picture of these aspects of the waves over the course of
a year-long data file, or indeed across multiple years if you have time.

• Surveying Specific Conditions: You may wish to take a converse approach, rather than going through the
ULF data to find events, you could choose a specific set of solar wind or magnetospheric conditions or previously
identified events found online and then investigate the magnetosphere’s ULF activity/response for these. Students
can look up published catalogues of events like Coronal Mass Ejections (CMEs), Corotating Interaction Regions
(CIRs) etc. or specific solar wind conditions like southward solar wind magnetic field. There are also magneto-
spheric activity indices which denote geomagnetic storms which may be of interest. Get in touch if you need help
finding this additional data.

Potential Topics

• When and where do specific types of wave events occur?

• How variable are the frequencies of certain types of wave events?

• When or how often do large amplitude ULF events occur?

• What were the causes of certain wave events?

• How effective are different solar wind structures or features at driving ULF waves?
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Because a lot of the underlying physics will be unfamiliar to students, they can focus purely on wave topics surround-
ing the data, as per the initial activites. They do not have to worry too much about explaining everything in the
context of the magnetosphere. If they make sufficient progress in identifying and characterising wave events, then the
magnetospheric context can be explored with help from the researchers.

You do not have to follow one of these approaches or topics, though do discuss thoroughly in your group and also with
your teacher before getting started with your research.

If you’re still unsure what to do, please tell your teacher to get in touch with us so we can visit
and provide guidance and assistance.

Be sure to collate all your results on ULF wave events into the provided spreadsheet template. Enter your data
into the white boxes, these will automatically calculate the dates, times and local times for you to save effort. You
will likely, however, need to add extra columns depending on your research topic so discuss what information it is you
need. You may also wish to use Audacity’s editing tools to save clips of specific types of events for cataloguing and/or
presenting your findings.

Remember, that this is a taste of real research so you will get stuck and the answers may not be known. This is why
it is important to persevere, discuss in your groups and with your teacher how to overcome any problems.

If at any point if you find yourself unable to continue or completely unsure about something, ask
your teacher to get in touch with us so that we can help you. On our website we also have advice
on how to integrate and support students with projects, based on other schools’ successful expe-
riences. Providing some structure for your students, and mostly just encouragement throughout,
is key to their and your success with these sorts of programmes.

5 Useful online resources

This guide is merely an introductory overview to the project and is by no means exhaustive. This means you will also
need to refer to other sources as you work on your project. Firstly we have a number of resources on the project’s
website (http://qmul.ac.uk/spa/musics) including video guides on how to use some features of Audacity specifically applied
to the space sounds (Audacity also has a very comprehensive manual covering all its features), and how to make scientific
posters or talks to present your work at our student conference. We also have a number of videos which go into some more
detail about aspects of these waves and examples of students’ previous work. However, there is plenty of information
about Earth’s magnetosphere, the waves present in it and how we detect them available online from a variety of sources.
Below are just some sources which you may find helpful:

MUSICS website (videos, how to guides): http://qmul.ac.uk/spa/musics

Audacity manual: http://manual.audacityteam.org/o/index.html

GOES magnetometers: http://www.swpc.noaa.gov/products/goes-magnetometer

Common ULF wave types/properties: https://wiki.oulu.fi/display/SpaceWiki/Geomagnetic+pulsations

Comprehensive overview of ULF waves:
http://www.igpp.ucla.edu/public/rmcpherr/McPherronPDFfiles/McPherron MagPul SurveysinGeophys.pdf

Overview of recent research: http://www-ssc.igpp.ucla.edu/gem/IAGA Div3/2011 Menk ULF.pdf

Sonification of data: http://dx.doi.org/10.1063/PT.3.1550
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